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Copyright 
Copyright © 1998-2007 Brooks Internet Software, Inc. 

Contact Information 
We invite you to contact us with 
your questions or comments on 
this manual or our software 
products: 
 
Brooks Internet Software, Inc. 
1820 E. 17th Street, Suite 330 
Idaho Falls, ID 83404-6400 USA 
 
Phone: (800) 523-9175 
            (208) 523-6970 
Fax:     (208) 523-9482 
Email:  support@brooksnet.com
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"ALL RIGHTS RESERVED" 
 
The copyright for INTELLIscribe, including but not limited to the INTELLIscribe executable, the Brooks License 
Manager files and help files, is owned by Brooks Internet Software, Inc. This software is not shareware or freeware. 
It is licensed commercial software. You are expressly prohibited from reproducing this software in any form, 
including making the software available on a network, except as allowed by the license agreement endorsed by 
Brooks Internet Software, Inc. 

Other Copyrights 
Windows is a trademark of Microsoft Corporation. 

Adobe, PostScript, Acrobat and the Adobe logo are trademarks of Adobe Systems Incorporated, which may be 
registered in certain jurisdictions. © 1987-1994 Adobe Systems Incorporated. 

JetDirect is a trademark of Hewlett-Packard Corporation. 

iNEWS is a trademark of iNews, LLC. 
 
ENPS is a registered trademark of the Associated Press. 
 
All other trademarks and symbols are property of their respective owners. 

The following copyright and license is applicable to the slp.dll file included with this application:  

Copyright (C) 2000 Caldera Systems, Inc 
All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:  

• Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer.  

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.  

• Neither the name of Caldera Systems nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission.  

 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”' AND 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE CALDERA SYSTEMS OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.  

Disclaimer 
Neither Brooks Internet Software, Inc. nor its employees make any warranty, express or implied, or assumes any 
legal liability or responsibility for the accuracy, completeness, or usefulness of any information, apparatus, product, 
or process disclosed, or represents that its use would not infringe privately-owned rights. 
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Introduction 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Print job 
A print job is a printer-ready 
document that is visible in the Print 
Jobs tab of INTELLIscribe. 
 

INTELLIscribe brings you new options for printing documents and gives you the 
power to intelligently manage printers.  Powerful, flexible, and easy to use, 
INTELLIscribe is the perfect tool to get more from your printing. 
 
Once set up on a Windows®-based workstation or server, printing with INTELLIscribe 
is just like routine Windows printing: select the INTELLIscribe printer you would like 
to print through, and click Print. 

More Options for Printing Documents 
Printing your documents in powerful ways just got a whole lot easier: Click Print once 
and have your news script sent simultaneously to eight network printers; reprint a copy 
of your sales forecast without opening the original application; print packaging 
information from your business office in Portland to your warehouse in Spokane. 
 
With INTELLIscribe, you can print your documents how you want and where you 
want, quickly and efficiently.  The following options will improve document printing: 
 
Broadcast Printing 
 
 
Easy Reprint 
 
 
Destination Selection 
 
Drag and Drop 
 
Command Line 
Interface 
 
Advanced User 
Interface 
 
Seamless Integration 
 

Print a document once and have it sent simultaneously to 
multiple network printers. 
 
Reprint documents without launching the original 
application 
 
Reprint a document to a specified printer 
 
Send printer-ready files without launching an application 
 
Submit one or more files from any folder with ISendFile. 
 
 
View port, job, and destination details; query a destination 
for status, track activities, and manage print jobs. 
 
Print efficiently from Windows applications because 
INTELLIscribe is fully integrated with the Windows Print 
Manager. 
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More Intelligent Print Environments 
In addition to giving you more document printing options, INTELLIscribe helps you 
achieve better printer utilization and establish more reliable print environments: 
distribute documents automatically between your office laser printers; print to any IP-
addressable printer; dynamically discover printers on your network.  The following 
options will help you get more from your printers and print environment: 
 
Fail-over 
 
 
Round Robin 
 
Destination Balancing  
 
 
 
Service Location 
Protocol (SLP)  
 
Protocols Supported 
 
 
Platform-independent 
Targets 
 
 
Ease of Use 

Reroute print jobs automatically to another printer if the 
specified printer fails. 
 
Print documents in turn to a sequence of printers. 
 
INTELLIscribe maintains statistics on the amount of data 
sent to each printer, and automatically sends new documents 
to the least used printer. 
 
Allows for dynamic discovery of destinations on a network 
 
 
INTELLIscribe supports the LPR/LPD and HP JetDirect 
protocols. 
 
Print to any TCP/IP addressable printer including midrange, 
mainframe, NT, UNIX, and Macintosh systems as well as 
hardware print servers. 
 
Easy-to-use Wizard provides step-by-step instructions to 
easily configure virtual printer ports.

How Others Are Using 
INTELLIscribe 
• Newsrooms are using 

INTELLIscribe’s broadcast 
printing function alongside their 
newsroom systems (iNEWS™, 
ENPS®, and others) to easily 
print scripts simultaneously to 
multiple network printers.  In 
many cases, these printers are 
loaded with specific colored 
stock for different people.  The 
SPA module allows network 
users in the newsroom access 
to INTELLIscribe’s broadcast 
printing. 

• Business Offices with multiple 
locations across the country 
are using broadcast printing to 
distribute reports to users at 
each location. 

• Universities are using round-
robin printing with multiple, 
inexpensive network printers to 
more evenly distribute print 
loads among printers and to 
minimize downtime. 

• Warehouses are using fail-
over printing to ensure that 
important reports are printed. 

• Offices are using destination-
balancing to even out printer 
usage among multiple printers 
so a single printer is not 
overused and so ink and toner 
replacements will happen at 
closer to the same time. 

• Data Warehouses are using 
INTELLIscribe’s reprint abilities 
to reprint one-time reports and 
queries that have been 
previously generated. 
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What is LPR/LPD? 
LPR/LPD is the printing protocol 
most commonly used in TCP/IP 
networks.  It is a computer-to-
computer printing method, rather 
than PC-to-PC.  LPR stands for 
Line Printer Requester—the part 
submitting the requests.  LPD 
stands for Line Printer Daemon—
the part that receives and 
processes the request. 
 
LPR/LPD is used extensively on 
university and business campuses 
where UNIX systems are common; 
the new generations of mainframe 
and business operating systems 
now support LPR/LPD. 
 
The LPR/LPD protocol is 
documented in RFC 1179. 

Daemon 
A daemon is similar to a “service” 
in Windows operating systems.  It 
is a program that runs, usually in 
the background, waits for certain 
events, and performs a function 
accordingly. 

LPR client 
INTELLIscribe is an LPR client.  
This term refers to a software 
product that uses the LPR/LPD 
protocol to send print jobs to an 
LPD Server. 

LPD server 
An LPD server is a software 
application that receives data 
using the LPR/LPD protocol from 
an LPR client.  There are many 
varieties.  RPM Remote Print 
Manager® is an LPD server.  
Many hardware print servers 
contain LPD servers in the 
firmware. 

How Does INTELLIscribe Work? 
Using the standard LPR/LPD protocol (see side note), INTELLIscribe prints 
documents to common network printers as well as to other printers or print servers 
supporting the LPR/LPD protocol including most UNIX, midrange, and mainframe 
systems. 
 
This means you are no longer limited to printing documents on printers connected 
directly to your computer or even to a local network: INTELLIscribe allows you to 
send documents to printers and print servers anywhere in the world using TCP/IP 
(Internet) technology.  For systems that do not support the LPR/LPD protocol, the 
Jetdirect™ protocol may be used. 
 
INTELLIscribe’s basic flow is as follows, assuming you have already configured a 
virtual print port and associated a Windows printer with it (discussed later): 

1 As usual, the application you are printing from (e.g. Word, Excel, Notepad, 
iNEWS, ENPS, etc.) uses the printer you have selected in the Print dialog to 
produce a document in the appropriate printer language (e.g. PCL, PostScript, 
and so on). 

2 Windows then notifies INTELLIscribe a document (also known as a print job) is 
ready to print.  The document is placed in the virtual printer port you have 
associated with the Windows printer. 

3 The virtual printer port sends the print job to a destination (see note below) 
based on the port’s configuration.  For example, if the port is set up for 
broadcast printing, the print job will be sent simultaneously to each destination 
(network printer) associated with the port. 

 
Note  The term destination is used interchangeably as print server and network 
printer.  Network printers don’t receive print jobs; that is done by a print server 
either integrated into the printer or connection externally to it.  You can also 
have a software print server. 
 
INTELLIscribe simply sends a document to a print server, and the print server 
decides what is actually done with it.  Most print servers print documents to a 
physical printer.  Others may provide additional functionality such as saving 
documents to a specified folder on a computer or network storage device. 
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Installing INTELLIscribe Installing INTELLIscribe Reporting Problems 
Our goal at Brooks Internet 
Software, Inc. is for you to receive 
the maximum benefit from our 
software products.  Sometimes 
you may require assistance even 
after reviewing the documentation.  
If this is the case, please contact 
us via email at 
support@brooksnet.com. 
 
• If you are researching a feature 

and the documentation is 
unclear, we ask that you 
explain what you are looking for 
and how the documentation 
does not seem to help.  If you 
have a suggestion on how it 
can be improved, please pass 
that along as well. 

• If INTELLIscribe does not seem 
to do what you expect, please 
tell us what you think it should 
do and why.  Many features 
included in our products come 
from user feedback and needs. 

 
If you experience a software 
failure, we ask that you do the 
following: 
 
1 Get a screen shot, or exact text 

of the failure. 
2 Retry the print job.  We want to 

know if it happens every time, if 
it is intermittent, or simply a 
one-time problem. 

3 Open the Log Window and 
view the events for any error or 
warning messages. 

4 Open the “About” dialog and 
determine the exact version of 
INTELLIscribe. 

5 Email a copy of all relevant 
information to 
support@brooksnet.com. 

6 Please be ready to provide 
further information, as it may be 
required to research and 
resolve the problem. 

INTELLIscribe is distributed with a Windows setup program, which guides you 
through the installation process on your computer.  The setup program installs and 
initially configures all files needed to operate the software. 
 
Here is the step-by-step installation process: 

1 Run the setup program downloaded from our website or the single file 
executable (intelliscribe.exe) located on the installation CD. 

2 Welcome  At the Welcome screen, click Next. 
3 License Agreement  After reading and agreeing to the terms of the software 

license, click Yes to proceed. If you choose No, setup will not continue. 
4 Select Destination Location  Choose the destination folder for INTELLIscribe. 

The default folder is C:\Program Files\Brooks Internet 
Software\INTELLIscribe. Click Next. 

5 Select additional tasks  Decide whether to add a shortcut icons in your Startup 
group, the desktop, or the Quick Launch toolbar.  INTELLIscribe runs as a 
service; these shortcuts are not necessary for program operation. 

6 Ready to Install  Setup displays information about your selections.  Review the 
information in this dialog.  If you want to make any changes, click Back.  When 
you click Install, all files necessary will be copied to your computer. 

7 Completing  Setup does not typically require you to restart your computer, but 
will prompt you to do so in some circumstances.  If so, choose Yes.  Setup will 
then restart Windows.  Note that setup configures INTELLIscribe to start 
automatically when the computer is restarted. 

Uninstalling INTELLIscribe 
You can uninstall INTELLIscribe by running the Add or Remove Programs utility in 
Control Panel.  Highlight INTELLIscribe and press the Add/Remove button (or 
equivalent). 

System Requirements 

Windows 2000/XP/Server 2003/Vista 
• Internet Explorer 5.01 SP2 or later 
• TCP/IP network 
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Quick Start Guide 
Getting started with INTELLIscribe involves two main steps: a) creating a virtual 
printer port and b) creating a Windows printer and assigning the virtual printer port to 
it. 

a. Set up a virtual printer port or ports 
In INTELLIscribe, selecting Add from the Port menu opens the Virtual Printer Port 
Wizard, which guides you through the following steps to create a virtual printer port: 

1 Configure Port  Enter a name for the port.  If multiple printing destinations will be 
used, choose a port policy (see side note). 

2 Add Destinations  Enter the hostname or IP address, then select a protocol and 
port for each new destination and click the Add Destination button. 

3 Configure Protocol Options  Customize each destination by entering protocol-
specific configuration. 

 
Note  These steps are outlined in more detail in the Setting up INTELLIscribe 
section. 

b. Create a Windows printer and assign the virtual printer port  
The Windows Add Printer Wizard guides you through this process.  This wizard 
accomplishes the following tasks. 

• Choose how this printer is connected to your computer: local or network.  
Windows considers a printer utilizing INTELLIscribe as a local printer.  Do not 
allow Windows to automatically detect your "plug and play" printer. 

• Select the port to which this printer will print.  Here you choose the virtual printer 
port created in the Virtual Printer Port Wizard. 

• Select the type of printer from a list of manufacturers and models.  If your printer 
is not listed, install the driver using the manufacturer supplied CD-ROM. 

• Choose from various other options such as whether to set the printer as the default 
and whether or not you wish to print a test page. 

• The Wizard allows you to select whether or not this printer will be shared.  See 
the note below for more information. 

• Provide a unique name for the printer. 

 
 
 

Virtual printer port 
A named port that associates a 
Windows printer with one or more 
network printing destinations 

Port Policies 
Port policies determine how a port 
selects a printing destination when 
a document is printed, and how 
the port handles a printer failure.  
Choosing the right policy is 
important when more than one 
printing destination is associated 
with a port.  If only one destination 
is available, the policy selection is 
ignored.  The following policies are 
available: 
 
• Broadcast/multicast: print a 

document once and have it 
sent simultaneously to multiple 
network printers 

• Round-robin: documents are 
printed in turn to a sequence of 
printers 

• Fail-over: when a printer fails, 
backup printers are available to 
print the document 

• Destination balancing: 
statistics are maintained on the 
amount of data sent to each 
printer; new documents are 
printed to the least used printer 

• SLP: query SLP servers for 
available printers, and the user 
selects the printer if more than 
one is found 
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Name Field: We recommend the 
port name be 32 characters or 
less.  You should also use a 
descriptive name such as "Printer 
in room 3" or "Office Printer."  This 
will be the name known by the 
Windows Print Manager. 
 
 
 
 
 
 
 
 
Port Policy: When more than one 
printer is entered, the printers 
must either be the same model or 
support a common print driver.  
For instance, two HP LaserJet 4 
printers can be used. 
 

Setting up INTELLIscribe 
The preceding Quick Start Guide section gave you a brief overview of the two general 
steps you will follow in setting up and configuring INTELLIscribe.  This section will 
provide more detailed setup instructions. 

Creating or Updating a Virtual Printer Port 
The Virtual Printer Port Wizard guides you through the steps of adding or updating a 
virtual printer port.   

1 To add a new port, select Add from the Port menu.  To update an existing virtual 
printer port, choose Update from the same menu.  A welcome screen explains the 
Wizard's purpose.  Click Next to begin configuring the port. 

2 Configure Port  The 
Configure Port step 
allows you to enter the 
name of the virtual 
printer port and select a 
port policy.  

Step 2:  Configure Port 

a. Name  This field 
should contain the 
name of the virtual 
printer port.  Each 
port must have a 
unique name. A 
name is required 
when creating a 
new virtual printer 
port; the name 
cannot be changed 
when updating a 
port.  The port name has no size limit and can contain most characters 
including spaces (see side note). 

b. Port Policy  Select the policy you want this port to use (see side note).  Port 
policies determine how a port selects a printing destination when a document 
is printed; the policy also determines how the port handles a printer failure.  If 
only one printing destination is available, the policy selection is ignored.  The 
available policies are outlined in the following table. When you have selected 
a policy, click Next. 

 
S e t t i n g  u p  I N T E L L I s c r i b e                                                                          6     
R e v i s e d :  3 / 8 / 2 0 0 7  
 
 



 

U s e r  M a n u a l  

3 Add Destination(s)  The Add Destinations step allows you to create a printer 
(destination) or printers that the virtual printer port will send documents to.  You 
will need to create more than one destination if you want to use the port policies 
(as discussed in Step 2b) effectively by sharing print duties between printers. 
a. Address  Enter the 

IP address or 
hostname of the 
printer or print 
server. 

b. Protocol  From the 
list, select the 
protocol you want 
this printer to use.  
You should verify 
that the protocol is 
supported by your 
print server.  Most 
hardware print 
servers support the 
LPR/LPD protocol. 

Step 3: Add Destinations 

Port Policy Description Use/Benefit 

Broadcast-
Multicast 

Print a document once and have it 
sent simultaneously to multiple 
network printers. 

• Simplify document 
distribution 

• Save time 
• Increase Efficiency 

Round Robin Documents are printed in turn to a 
sequence of printers. 
 

• Automatic printer selection 
• Better utilization of 

resources 

Fail-over When a printer fails, backup printers 
are available to print the document. 

• More reliable printing 

Destination 
Balancing 

Statistics are maintained on the 
amount of data sent to each printer; 
new documents are printed to the 
least used printer. 

• Better resource utilization 

SLP (Service 
Location 
Protocol) 

Queries the network for a list of 
available printers.  A user selects the 
printer if more than one is found.  In 
the Destinations window, users can 
select a printer as the default, which 
is then printed to regardless of how 
many printers are available. 

• Reduces the amount of 
technical knowledge and 
training required for end 
users 

• A SLP server must be 
present on your network 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hostname 
A host name is the name assigned 
to a host computer on a TCP/IP 
network. It must be unique on the 
network.  Often, you can substitute 
the IP address for a host name. 
Ask your network staff for 
assistance. 
 

IP Address 
An IP Address is a 4-octet number 
that is used by TCP/IP to identify a 
device (or node) on the network.  
An LPR client needs the IP 
Address of the LPD server in order 
to send data to it. 
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c. Port  Enter the TCP/IP port number you want to send data on.  The default 
port number for LPR/LPD is 515 and is entered automatically.  Most single-
port JetdDirect print servers receive data on port 9100; this port number is 
entered automatically when selecting the JetDirect protocol. 

d. Destination(s)  This box contains a list of destinations (printers) that have been 
created for the port.  If updating an existing port, the list should be populated 
automatically. 
i. Buttons  The Up  and Down  buttons increase or decrease the priority 

of the selected destination.  If only one destination is available or if the 
destination is already the highest (or lowest) priority, the buttons do not 
perform any operation. The Delete  button deletes the selected 
destination, but there must be at least one destination to continue. 

4 Configure Destination Options  This final step allows you to customize the 
configuration of each destination (see side note).  This step has protocol-specific 
attributes, as well as destination-specific settings.  You must specify a Queue 
Name for each destination using the LPR/LPD protocol (see side note). 
a. Destination(s)  This 

lists all destinations 
that have been 
entered in the 
previous step.  
Highlighting a 
different destination 
populates the 
Settings list with the 
destination’s 
current 
configuration. 

Step 4:  Configure Destination Options 

b. Settings  The 
Settings list 
displays either an 
LPD or JetDirect 
options list 
depending on the highlighted destination.  Each protocol has a different set of 
options that can be configured. 

i. LPD Options List  The following table describes the LPD settings: 

Parameter Description 

Queue Name This is a required parameter:  Name of the queue on the 
LPD server (see side notes). 

Copies Notify the print server to print a specified number of 
copies.  In most cases, hardware LPD servers cannot 
print multiple copies with this setting, but software LPD 
servers can. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Configure Options: Always 
attempt to print using the default 
settings first; then modify these 
settings as needed.  Normally, the 
default attributes are sufficient. 
 
 
LPD Queue Names: A list of LPD 
queue names for common network 
printers and servers is available on 
Brooks’ website. 

LPD Queue Name 
Within most LPD servers, you can 
configure a queue with specific 
characteristics.  LPD queues are 
uniquely identified by their name.  
Each queue may have different 
characteristics.   When LPR clients 
send data to an LPD server, they 
must specify a queue name. 

LPD server 
An LPD server is a software 
application that receives data 
using the LPR/LPD protocol, which 
is part of the TCP/IP suite of 
protocols, from an LPR client.  
There are many varieties.  RPM 
Remote Print Manager® is an LPD 
server.  Many hardware print 
servers contain LPD servers in the 
firmware. 
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Parameter Description 

Port Restriction Configures the LPR/LPD client port restriction.  This is the 
source port, not the destination port which is typically 515. 
Available settings are: 
• Relaxed: no restrictions on available client ports 
• Standard: any port less than 1024 can be used 
• Strict: only ports in the range of 721-731 are used 

Print Banner Request that a banner page be printed with the document 
or not 

Indent Count Tell the printer what the left margin is, depends on the 
Print Format setting. 

E-mail Address Request that the print server send email to the recipient 
specified here.  Most LPD servers do not support this 
option. 

Page Width Specifies the width of the document in number of 
characters.  This option may not be supported by most 
LPD print servers. 

Banner Class Sets the class name to be printed on the banner page. 

Print Format Informs the LPD what type of file is being sent.  Most LPD 
servers ignore this setting. 

Reverse Order Forces the application to send the control file last. 

Control File Ack Wait for an acknowledgment after sending the control file 
before proceeding. 

Data File Ack Wait for an acknowledgment that the data file was 
received before proceeding. 

Ignore Final Ack Regardless of information received from the printer, 
INTELLIscribe will consider a document printed if all the 
data in the document has been sent. 

Timeout Sets the number of seconds of inactivity before closing a 
connection. 

LPD Status Select whether you wish to receive a long or short queue 
status when testing. 

Log Detail Allows you to set log detail for the destination.  If you 
select the default, use global, INTELLIscribe will use the 
setting configured in the Global Options Dialog. 

ii. JetDirect Options List  The following table describes the JetDirect 
settings: 
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Parameter Description 

Print Banner Forces INTELLIscribe to insert a PCL banner page prior 
to spooling. 

Copies Request that the print server print a specified number of 
copies 

Solicit Device 
Status 

Request status about the JetDirect device while printing 

Solicit Job 
Status 

Request status about the print job while printing 

Solicit Page 
Status 

Request status about the current page while printing 

Timeout Sets the number of seconds of inactivity before closing a 
connection. 

Query Status These settings specify information requested when 
querying the destination: 
• ID  The model number of the printer (e.g. LaserJet 4) 
• Status   Obtain the current status of the printer 
• Config  Obtain configuration information, such as 

paper sizes 
• Filesystem  Obtain PJL file system information 
• Memory  Determine the amount of memory the printer 

has installed 
• Page  Obtain the number of pages printed by the 

current print engine 
• Variable  Obtains environmental and printer variables, 

possible values, and current settings 
• USTATUS  Obtains the unsolicited status variables, 

possible values, and their current settings 

Log Detail Allows you to set log detail for the destination.  If you 
select the default, use global, INTELLIscribe will use the 
setting configured in the Global Options Dialog. 

5 After you finish configuring the destinations, click Next.  Then click Finish on 
the completion page to complete the process of adding (or updating) your virtual 
printer port. 

 
Note  After creating the virtual printer port, follow the instruction on page 5 to create a 
Windows printer and assign the virtual printer port to it.
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Drag and Drop Example: After 
printing a news script through a 
port configured for broadcast 
printing, you could drag the script 
print job from the Print Jobs tab to 
another virtual printer port that 
may be set to broadcast the script 
to another set of printers. 
 
New Drag and Drop Use: Print 
jobs can also be dragged from 
INTELLIscribe and viewed in 
editors that support drag and drop 
(e.g. Notepad, Outlook, and so 
on).  You might use this feature for 
troubleshooting purposes. 
 
 

Using INTELLIscribe 
After you have set up the virtual printer port or ports in INTELLIscribe and created a 
Windows printer and assigned the virtual printer port to it, you are ready to begin 
printing through the port and using INTELLIscribe’s other features.   

Printing with INTELLIscribe 
Printing through INTELLIscribe from other applications is just like normal Windows 
printing:  

1 In the application you are using (e.g. Word, iNEWS, Excel, ENPS, and so on), 
access the Print dialog as usual and select the Windows printer you created and 
linked to the INTELLIscribe virtual printer port. 

2 Click Print.  The document is printed through INTELLIscribe using the port’s 
policies and settings.  For example, if you have set up a virtual printer port that 
uses the broadcast policy, the news script you print once from iNEWS (or other 
application) is printed automatically to each network printer associated with the 
port. 

Working with Print Jobs 
After you have printed a document through INTELLIscribe, it is displayed in the Print 
Jobs tab of the virtual printer port through which it was printed.  The displayed print 
job represents the printer-ready document stored in INTELLIscribe’s Spool directory.  
You can work with these print jobs in a number of ways: drag jobs from one port to 
another; reprint, cancel, or delete a job; reprint a copy of a job to a destination of your 
choice; or view a job’s properties. 

Drag-and-Drop Printing 
In INTELLIscribe, you can drag printer-ready files to any virtual printer port.  In 
addition, you can drag a job from one virtual printer port to another (see side note).  
The following steps describe how to use drag-and-drop printing: 

1 Select a printer-ready file (for example, using Windows 
Explorer) or a print job in the Print Jobs tab of 
INTELLIscribe. 

2 Drag the file or print job directly over the virtual printer 
port you want to print through. 

3 Drop the file or print job onto the virtual printer port.  
Your file or print job is printed through the selected 
virtual printer port. INTELLIscribe sends the document to 
the desired printer(s) without launching an application or 
involving the Windows print driver. Step 2:  Virtual Printer 

Ports List 
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Reprinting Documents  
 
 
Reprint Note: Reprinting in this 
way does not require that you 
launch the application that was 
originally used to print the 
document. 
 
Select Multiple Jobs: To select 
multiple jobs to reprint, cancel, or 
delete, hold the Ctrl or Shift keys 
while selecting another job. 
 

Using INTELLIscribe, you can easily reprint documents.  Complete the following steps 
to reprint a job: 

1 In INTELLIscribe, select the document or documents you want to reprint. 
2 Right-click and select Reprint from the Job menu.  Or, press the reprint button 

 on the toolbar.  The document is reprinted. 
 
You can also reprint a job to a destination of your choice.  At the bottom of the Print 
Jobs tab, the Print Selected Jobs To list allows you to print the selected print job(s) to 
the destination of your choice.  This destination is displayed in the form of 
host:port_number:queue.  Complete the following steps to print a job to a selected 
destination: 

1 In the Print Jobs tab, select the job or jobs you want to reprint (see side note). 
2 From the Print Selected Jobs To list, select the destination you want to print the 

job to. 
3 Click Print.  The print job or jobs are immediately scheduled to print to the 

destination selected in the list. 

Canceling Print Jobs 
After a print job has been scheduled to print, you can cancel it.  Complete the following 
steps to cancel a print job: 

1 In the Print Jobs tab, select the print job you want to cancel. 
2 Right-click the print job and select Cancel.  The job is canceled. 

Deleting Print Jobs 
You can delete print jobs from the Print Jobs tab and permanently remove them from 
the INTELLIscribe’s Spool directory.  Complete the following steps to delete a print 
job: 

1 In the Print Jobs tab, select the print job you want to delete. 
2 Right-click the print job and select Delete.  The job is permanently deleted. 

Viewing Print Job Properties 
You can view detailed information about each print job.  To view a print job’s 
properties, complete the following steps: 

1 In the Print Jobs tab, select the print job whose properties you want to view. 
2 Complete one of the following steps to open the Job Properties box: 

a. Double-click the print job. 
b. Right-click and select Properties. 
c. Select Properties from the Job menu. 
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3 In the Job Properties box, you 
can view the following 
information about the print job: 
a. General  The General section 

displays the job identification 
number and the job status. 

b. Settings  The Settings section 
displays information about the 
job’s settings: 
i. User  The name of the user 

who submitted the job. 
ii. Host  Hostname of the 

computer. Step 3: Job Properties Dialog Box 

iii. Source  Information about 
where the print job originated. 

iv. Port  The virtual printer port that the job was submitted to. 
v. Document  The name of the print job or the name of the file if the 

document name is not available. 
vi. Datafile  The path to locate the file on your computer. 
vii. Copies  The number of copies that were requested. 

c. History  Displays the date and time when the print job was received, 
scheduled, and completed (i.e. when the print job finished printing). 
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Working with Destinations 

Once you have set up Although most destinations are network printers, it is possible to 
set up destinations in INTELLIscribe that are not network printers. 

 

Viewing SLP Printer Attributes 
You can view detailed information about an SLP destination.  Only destinations found 
through the Service Location Protocol (SLP) can display attributes.  Read more about 
Service Location Protocol. 
 
Attributes must be configured at the service or directory agent.  Information in the 
Attributes dialog is not static, nor can it be configured using INTELLIscribe.  The 
information is obtained from other SLP agents through TCP/IP. 
 

Step 2: Attributes Dialog Box 

To view a destination’s attributes, complete the 
following steps: 

1 In the Destinations tab, select the SLP 
destination whose attributes you want to 
view. 

2 Either right-click the destination and 
select Attributes, or select Attributes from 
the Destinations menu.  The destination’s 
attributes are displayed in the Attributes 
box. 

Querying a Destination’s Status 
You can query a destination for status information, including address, protocol, port, 
print jobs, and so on.  Complete the following steps to query a destination for status 
information: 

1 From the Virtual Printer Ports list, select the virtual printer port associated with 
the destination you want to query. 

2 In the Destinations tab, select the destination. 
3 Right-click the destination and select Query Status… The status information is 

displayed in the information box near the bottom of the Destinations tab. 

Deleting a Port 
Deleting a port removes the port, all the jobs in the port, and the virtual printer port 
configuration.  More than one virtual printer port can be deleted at a time.  Complete 
the following steps to delete a port or ports: 

1 Complete one of the following steps to open the Delete Port dialog box: 
a. Select Delete from the Port menu 
b. Highlight the virtual printer port in the Virtual Printer Ports list, right-click, 

and select Delete. 
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service agent 
An SLP software application used 
to broadcast the existence of 
network services. 

directory agent 
A SLP term that describes a 
centralized repository for service 
location information.  
 
 
Note: The information in the 
Attributes box can be copied to the
clipboard, but it cannot be edited. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select Multiple Ports: To select 
multiple ports for deletion, hold the 
Ctrl or Shift keys while selecting 
another port. 
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c. Highlight the virtual printer port in the Virtual Printer Ports list and click 
Delete on the keyboard. 

Step 2:  Delete Ports Dialog Box 

2 In the Delete Port dialog box, select the 
virtual printer port you want to delete 
and click Delete Port (see side note).  
The port is deleted.  If any print jobs 
associated with the port are active (i.e. 
are printing or being transferred), those 
print jobs will be cancelled prior to the 
port being deleted.  All destinations, 
print jobs, and configurations of the port 
are removed. 

 
Note  You cannot undo a port deletion operation.  Once the port is deleted, it 
cannot be retrieved. 
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Destination Logging:  The log 
detail can be customized for each 
destination.  If you want a different 
log level for a destination, update 
the Log Detail setting in the 
Settings section of the Configure 
Settings step in the Virtual Printer 
Port Wizard. 
 

Setting INTELLIscribe’s Options 

You can set options related to INTELLIscribe in general (log, failure notification, and 
splash screen), print jobs (deletion, spool directory, and retry), and Service Location 
Protocol (SLP).  Complete the following steps to change INTELLIscribe’s options: 

1 Select Options… from the View menu.  The Global Options dialog box is 
displayed with its three tabs (General, Job Options, and SLP). 

2 General Tab Click the General tab 
to set global options for 
INTELLIscribe. The following 
options can be set: 
a. Log  These options relate to 

the log files INTELLIscribe 
maintains. 
i. Log Detail  Sets how 

logging is done.  You can 
choose None, Low, or 
High.  When High is 
selected, the maximum 
amount of logging is done 
for each destination (see 
side note). 

Step 2:  General Options Tab 
ii. Remove Log Files Older 

Than _ Days  Determines 
how often the log files are 
deleted.  You can enter the number of days you want to pass before the log 
files are deleted. 

iii. Log Directory  Allows you to browse for the location where you want the 
log files will be stored.  Click the Browse button to change the location 
where the log files are stored.  The current path where the files are stored is 
shown below the Browse button. 

b. Failure Notification   When automatic failure notification is checked, a 
message box is displayed for each job that fails printing.  Deselect the Failure 
Notification option if you do not want to view the message notification.  The 
errors and warnings will still be logged and can be viewed in the Log tab. 

c. Splash Screen  When Enable Splash Screen is checked, the INTELLIscribe 
splash screen is displayed when INTELLIscribe starts.  Uncheck the option 
to disable the splash screen. 

3 Job Options Tab  Click the Job Options tab to set options related to print jobs. 
a. Job Deletion  The Job Deletion option allows you to decide how and when 

you want to delete print jobs archived in the INTELLIscribe spool directory. 
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i. Delete Jobs After They Are 
Printed  Select this option if 
you want the print jobs to 
be automatically deleted as 
soon as they have printed. 

ii. Delete Printed Jobs After _ 
Days  Select this option if 
you want to specify the 
number of days that 
archived print jobs are kept.  
For example, enter 2 if you 
want print jobs to be 
removed after they are 2 
days old. 

Step 3: Job Options Tab 

iii. Delete Printed Jobs When 
Quantity Exceeds  Select 
this option to preserve only 
a certain number of print 
jobs.  When the specified number of print jobs in the spool folder is 
exceeded, the oldest jobs are deleted automatically. 

iv. Include Failed Print Jobs in Job Deletion Options  Select this option in 
conjunction with one of the job deletion options discussed above if you 
want print jobs that fail or have been cancelled to also be removed when 
the job deletion criteria are met. 

b. Spool Directory  You can specify the folder where you want spool files 
(archived print jobs) to be stored.  Click the Browse button to change the 
location where the spool files are stored.  The current path where the files are 
stored is shown below the Browse button. 

c. Job Retry  You can specify 
the number of times a 
destination is tried before the 
destination is considered in 
error.  The print job is 
automatically tried once, and 
then the number of retries 
begins.  From the list, select 
the number of times you want 
to retry. 

4 SLP Options Tab  Click the SLP 
Options tab to configure the 
protocol settings that are 
applied to any new destinations 
that are added during the 
course of operation.  This tab 
shows all protocol options for 
LPR/LPD destinations Step 4: SLP Options Tab 
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currently (see side note).  More protocols may be added here when other 
protocols support the service location protocol. SLP Note:  Queue name is not 

configurable in this dialog because 
the queue name is learned 
through SLP. 
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Working with Configuration Files 

 
 
 
 

XML Format (*.xml) 
Configuration files are exported in 
XML format.  This format is more 
flexible than *.reg format and 
allows INTELLIscribe to more 
easily handle importing 
configurations. 
 

 

 

 

Registry Format (*.reg) 
INTELLIscribe can import registry 
format (*.reg) configurations from 
previous INTELLIscribe software 
versions; however, if the registry 
files are not specific to 
INTELLIscribe configuration, they 
will not be imported. 

Exporting Configuration Files 
You can export a configuration file that contains your virtual printer port 
configurations.  These configuration files can be used for backup purposes or to 
replicate a configuration on any number of other computers running INTELLIscribe 
(see side note).  Complete the following steps to export a configuration file  
 

1 From the File menu, 
select Export... 

2 Enter a name for the 
configuration file in the 
File name field. 

3 Browse for the folder in 
which you want to save 
the file. 

4 Click the Save button.  
The .xml configuration 
file is saved in the 
specified location. 

 

Importing Configuration Files 
You can import a configuration file that contains virtual printer port configurations 
from another instance of INTELLIscribe. This option locates files with a .reg or .xml 
extension only.  You cannot browse for other file extensions.  Complete the following 
steps to import a configuration file: 
 

1 From the File menu, select Import… 
2 Navigate to the folder where the configuration file (in *.xml or *.reg format) is 

stored. 
3 Select the configuration file and click Open.  The virtual printer port 

configuration is imported into INTELLIscribe.  The imported ports are 
displayed in the Virtual Printer Ports list. 
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About Dialog: This dialog is used 
to display information about the 
application and will be requested 
when obtaining technical support. 
 
License Information: If the 
software has not yet been 
unlocked, the username and 
company shown are obtained from 
Windows. 
 
Technical Support: Before you 
submit a problem report, please 
see the Reporting Problems 
section   Also, if you have Internet 
access, you can search the online 
support section of our website 
(FAQ Index); here  you can search 
for common problems or situations 
encountered with this application 
or other products. 
 
 

Viewing Information about INTELLIscribe 

To view information related to INTELLIscribe, including serial number, version 
number, and so on, complete the following steps (see side note): 
 

1 Select About INTELLIscribe… 
from the Help menu.  The About 
INTELLIscribe dialog box is 
displayed.  The box contains the 
following information: 
a. License Information Displays 

the license information 
including username, 
company, and serial number 
(see side note). 

b. File Versions  The version 
number of each file in the 
INTELLIscribe installation 
folder is displayed. 

Step 1:  INTELLIscribe About Box c. Support Contact Information 
Provides information that will 
help you obtain technical support on Brooks’ website, over the phone, by 
email, or by fax (see side note).   
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ISendfile Command Line Interface 
 
Error Handling: If ISendfile does 
not understand the command line, 
or if it cannot connect to 
INTELLIscribe, it prints an error 
message and exits. 

ISendfile Requirements 
• The user must have one or 

more virtual printer ports, 
created with the Virtual Printer 
Port Wizard. 

• The virtual printer port named 
must exist.  Port names can 
contain spaces (see the 
ISendfile Examples section). 

• The file or files named must 
exist and must be readable (i.e. 
user must have permission to 
read them). 

 

ISendfile is a utility program provided by INTELLIscribe.  Its purpose is to provide a 
DOS command line interface for printing one or more files to a virtual printer port.  
ISendfile can be called from a DOS command prompt, or a DOS batch file.  It does not 
open a window or prompt for user input (see side note). 
 
 Applications of this feature include: 

• Sending large files to a directory and automatically printing them during low 
impact hours by an automatic call (e.g. batch file) to ISendfile.   

• Sending files to another host on the network by a call to ISendfile after running 
another local program. 

The ISendfile Interface 
To obtain help with ISendfile, type the following text: ISendfile --help.  If you 
do, the text below will be displayed: 
 

 

Usage: isendfile [ options ] port file 
Options include: 
 --help          Display this help text 
 -v | -–verbose  Print messages about ISendfile actions 
 -s              Silent, opposite of verbose 
 -h              No banner for this job 
 -F=format       Format is one of the following: 
      f - formatted, l - leave control characters, o - Postscript 
      p - use 'pr' format, r - FORTRAN, c - CIF, d - dvi, g - plot 
      n - ditroff, t - troff, v - raster 
 -C=class        Class is used on banner page; up to 31 characters 
 -T=title        Job title 
 -J=jobname      Job name 
 -K=copies or -#=copies   Number of copies of each file to be printed 
 -P=port         Equivalent to the 'port' argument 
 -U=username     Specify a username; otherwise use the logged-in username
   -i=columns    Indent input by columns (LPD only) 
   -w=width      Specify the page width (LPD only) 
   -H=host       Hostname that jobs comes from, defaults to local computer name 
   -Z=options    Pass the specified options 
 
 

 Command line ISendfile help 

ISendfile Options, Variables, and Messages 
The following tables explain in greater detail the ISendfile command line options, 
environment variables, and error messages: 
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ISendfile Table 1: Options  
 

Option Explanation 

--help Display this help text 

-v 
--verbose  

Print messages about ISendfile actions 
(this is the default) 

-s Silent, opposite of verbose.  ISendfile will not print a message about each 
file it sends, but errors are still printed. 

-h  If INTELLIscribe prints the file to an LPD destination, then it suppresses the 
banner page 

-F=format     Format is one of the following: 
        f - formatted, l - leave control characters, o - Postscript 
        p - use 'pr' format, r - FORTRAN, c - CIF, d - dvi, g - plot 
        n - ditroff, t - troff, v – raster 

-C=class The job class is typically used by LPD servers on the banner page; some 
servers ignore it 

-T=title      Job title, which may be used on a banner page or with ‘pr’ format 

-J=jobname    Job name; may be used on a banner page 

-K=copies 
-#=copies 

Number of copies of each file to be printed 
Note that not all print servers support the copies option 

-P=port Equivalent to the 'port' argument 

-U=username Specify a username; otherwise use the logged-in username; 
LPD print servers typically expect a username 

-i=columns Indent input by columns (LPD only) 

-w=width Specify the page width (LPD only) 

-H=host Hostname that jobs comes from, defaults to local computer name 
LPD print servers typically expect an originating hostname, though if one is 
not provided then it will use other means to determine a valid hostname. 

-Z=options Pass the specified options.  This is used by some print servers for custom 
processing. 

Variable Usage 

PRINTER ISendfile will use this as the port to send files to, if you do not specify the 
port with the –P option or as a command line argument 

USERNAME ISendfile will use this as the user requesting the print job if you don’t specify 
the –U option 

ISendfile Table 2: Environment Variables 

 
U s i n g  I N T E L L I s c r i b e                                                                          2 2     
R e v i s e d :  3 / 8 / 2 0 0 7  
 
 



 

U s e r  M a n u a l  

 
Message Resolution 

** Filter format is one 
character only: 

If you use the –F switch, the value you specify must be 
exactly one character 

** Indent must be digits 0-9 
only: 

If you use the –i switch, the argument must contain digits 
only. 

** Width must be digits 0-9 
only: 

If you use the –w switch, the argument must contain digits 
only 

** Unexpected options You have specified options that ISendfile did not expect..  
One reason might be reversing upper or lower case; 
ISendfile options are case sensitive. 

** Missing port or filename You must always specify a filename or file spec (using * or ?)  
The port must be specified as an argument, an option or 
environment variable. 

Failed to create print job in 
INTELLIscribe 

Run the INTELLIscribe user interface and check the log 

Job was created in 
INTELLIscribe but has no 
properties 

Run the INTELLIscribe user interface and check the log 

Job is waiting in 
INTELLIscribe, not submitted 

The most likely reason is that the INTELLIscribe trial period 
has ended.  Run the INTELLIscribe user interface and check 
the log. 

To get program options type 
'isendfile –help' 

This is the “brief” message which is not an error by itself; it 
accompanies other error messages. 

** Error checking file ‘file’ : ISendfile tried to get information on a file, but failed. 

** 'file' is a directory ISendfile can’t send directories 

** 'file' is not a file ISendfile can only send regular files 

** 'file' is empty ISendfile won’t send empty files 

** Port 'name' is not defined The port you send to must be defined in INTELLIscribe.  
Other Windows ports are not supported. 

** Error checking port 
definition 

IServ, the INTELLIscribe service, is not providing port 
information.  It might not be running.  Please run the 
INTELLIscribe user interface and check the log. 

ISendfile Table 3: Error Messages 

 
U s i n g  I N T E L L I s c r i b e                                                                          2 3     
R e v i s e d :  3 / 8 / 2 0 0 7  
 
 



 

U s e r  M a n u a l  

ISendfile Examples 
The following examples assume that you have already created a virtual printer port 
named “Office”.  Help with creating a printer port can be found in the Setting Up a 
Virtual Port section.  Note that the virtual printer port names are case sensitive. 
 

ISendfile Table 4: Examples 

 
 

Example Command Line 

To print all text files in a 
directory: 

ISendfile.exe Office c:\path\to\*.txt 

To specify an alternate 
print format: 

ISendfile.exe –F=o Office c:\path\to\file.txt

To specify 3 copies to 
print: 

ISendfile.exe –K=3 Office c:\path\to\file.txt

 
Spaces: If either the virtual printer 
port or file path contains spaces, 
enclose it in quotation marks.  An 
example is: 
 
ISendfile “Office 
Printer” “c:\file with 
spaces.txt” 
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User Interface Guide 
This section explains the windows, tabs, and menus found in the main INTELLIscribe 
window. 

INTELLIscribe Window 
The main INTELLIscribe window resembles a typical Windows application.  Starting 
from the top, it contains a title bar, menu bar, and toolbar.  Directly beneath the toolbar, 
the tabs are shown along with the status bar. 

A 

E 
B 
C   
F 

 

 

 
G 

 
A. Menus B. Toolbar C. Virtual Printer Port Tab D. Print Jobs Tab E. Destinations Tab F. Status 
Bar G. Log Tab
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Click the links to the left to learn 
more about the corresponding 
section of the INTELLIscribe 
window. 
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A. INTELLIscribe Menus 

The following table describes each menu item and the function it performs.  In addition 
to the standard menu in INTELLIscribe, an INTELLIscribe icon  is also displayed in 
the task tray: 
 

Menu Command Description 

File Import… Imports virtual printer ports if you have previously 
exported a configuration file.  When a configuration file 
is imported, the virtual printer port setup is merged with 
the current configuration (see side note). 

 Export… Once virtual printer ports are configured, the virtual 
printer ports may be exported to a file (see side note).   

 Exit Close the INTELLIscribe user interface.  This does not 
stop the application from printing.  To place the user 
interface in the task tray, use the minimize button. 

Port Add… Add a new Virtual Printer Port. 

 Update… Update the selected virtual printer port. 

 Delete… Delete a virtual printer port. 

Job Cancel Cancels a print job, unless it has been printed or is in 
error.  If it has not yet completed printing, this action 
will prevent it from being printed in most cases, 
depending on the print server (see side note). 

 Delete Deletes the selected print job(s). Documents that are 
being printed cannot be deleted until they have finished 
successfully, failed, or have been manually cancelled 
by the user.  

 Reprint Reprint the selected print job(s). The currently selected 
print jobs are rescheduled for printing.  INTELLIscribe 
will then spool the print job to the printer again, even if 
it failed or did not print the first time through. 

 Properties… Displays the job properties for the selected document 
by displaying the Properties dialog. 

Destination Query Status… Queries a printer for information.  Queries a destination 
for availability and other useful information.  The query 
used is specific to the protocol configured for the 
destination.  Information is returned by the printer or 
print server and can be copied to the clipboard. 

 
 
 
 
 
 
 

 
Import…: System administrators 
may use this to simplify the setup 
of INTELLIscribe for multiple 
computers. 
 
Export…:  Use the Export 
command to: 
• Quickly configure several 

computers with the same virtual 
printer port configuration. 

• Backup the configuration for 
use in a catastrophic event 
such as a computer crash. 

 
 
 
Job Menu: You must have a 
document selected in the Print 
Jobs tab for the Job menu 
commands to be available.  You 
can also access this menu by 
right-clicking any of the print jobs 
in the Print Job tab. 
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Menu Command Description  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
License Manager: The license 
manager allows you to check your 
trial status, register INTELLIscribe, 
contact Brooks Internet Software, 
Inc., and print your license if it has 
been unlocked. 
 
 

 Update Allows modification of destinations.  Opens the Virtual 
Printer Port Wizard and allows you to modify, remove, 
or add destinations. 

 Set as Default Sets the selected destination as the default destination.  
This option is only available for ports with the port 
policy Service Location Protocol (SLP).  Subsequent 
print jobs immediately print to the default destination 
without user intervention.  This option can be turned on 
or off with this command. 

 Attributes Some SLP destinations may have further information 
about the destination and can be viewed with this 
command.  The Attributes dialog is opened if 
information is available; otherwise a warning message 
is displayed. 

Log Open Log… Allows you to select the log file you want to view in the 
Log tab.  The log files are named by date. 

 Today’s Log Allows you to quickly view today’s log in the Log tab. 

 Refresh Refreshes the log being displayed in the Log tab. 

View Toolbar Hides or displays the Toolbar. 

 Status Bar Hides or displays the Status bar. 

 Options… Displays the Global Options dialog.  In this dialog you 
can change the general log and program options, job 
options, and SLP options. 

Help Help Topics Displays the INTELLIscribe Help file.  You can access 
instructions and other types of reference information in 
the Help file. 

 License Manager Opens the Brooks License Manager. 

 About 
INTELLIscribe 

Displays the About INTELLIscribe box, which shows 
the user name, company, serial number, version of 
INTELLIscribe, and other information. 

Task Tray 
 

Open 
Exit INTELLIscribe 

Place the mouse cursor over the task tray icon to see 
the name of the product or the status of print jobs if 
they are being printed.  You can restore INTELLIscribe 
by double clicking the task tray icon.  Right-click the 
icon and select Open to open the INTELLIscribe 
window, or select Exit INTELLIscribe to close the user 
interface completely. 

 File Menu Commands Table 
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B. Toolbar 

The toolbar is displayed by default or by selecting Toolbar from the View menu. To 
hide the toolbar, uncheck Toolbar from the View menu.  The following table describes 
the function of each button:  
 
Button Function 

 Cancels printing the selected job if not already printed. 

 Deletes the print job from the list. 

 Reprints the currently selected print job(s). 

 Displays the job properties for the selected job. 

 Accesses the Brooks License Manager. 

 Displays the application About dialog. 

Toolbar Buttons Table 

 

C. Virtual Printer Port Tab 

The Virtual Printer Ports tab contains a list of the printer 
ports that have been configured.  Selecting a virtual printer 
port displays the print jobs that have recently printed or are 
waiting in the Print Jobs tab. 

• If you right-click a virtual printer port, the Port menu will 
be displayed allowing you to update the port or create a 
new port.  This menu also provides the ability to delete 
the selected port. 

• Click the Destinations tab to see the destinations 
associated with the selected port.  You can quickly view 
information about a destination using this view. 

 Virtual Printer Ports Tab 

 
U s e r  I n t e r f a c e  G u i d e                                                                          2 8     
R e v i s e d :  3 / 8 / 2 0 0 7  
 
 



 

U s e r  M a n u a l  

D. Print Jobs Tab 

The Print Jobs tab 
contains a list of print 
jobs that INTELLIscribe 
has printed, is currently 
printing, has failed to 
print, and so on for the 
currently selected virtual 
printer port. 
 

Print Jobs Tab 

The Print Jobs tab also 
displays the job 
identification number, 
job name, user who 
printed the job, status, time scheduled, and time completed for each print job.  You can 
sort the list by any column. 
 
At the bottom of the tab, the Print Selected Jobs To list allows you to print the selected 
print job(s) to the destination of your choice.  When you click the Print button, the jobs 
are immediately scheduled to print to the destination selected in the list.  This 
destination is displayed in the form of host:port_number:queue.  The :queue is not 
always displayed, depending on the setup. 
 
A small icon next to each print job represents the current status of the job.  The 
following list explains what each icon represents: 
 

 

Icon Meaning 

 The status has not been decided. 

 The job is waiting but has not been scheduled. 

 The job is waiting to print and has been scheduled. 

 The job is currently printing. 

 The job has an error and was not printed. 

 The user has cancelled printing this job. 

 The print operation completed successfully. 

Print Jobs Tab: Icon Meanings 
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E. Destinations Tab 

The Destinations 
tab displays the 
destinations 
associated with 
the selected port.  
 
From this tab, 
you can query the 
status of the 
selected 
destination.  The 
information 
returned from the 
destination 
depends on which protocol is used, LPR/LPD or HP JetDirect. 
 
Clicking the Update button opens the Virtual Printer Port Wizard of the associated port 
to the Add Destinations step of the Wizard, allowing you to add, remove, or modify the 
destinations of the virtual printer port. 
 
A small icon next to each destination represents the current status.  The icons and the 
status are as follows: 
 
Icon Meaning 

 The current state of the destination is unknown 

 The destination is currently available 

 The destination is busy or is not responding 

 The destination is currently being tested 

 An error has been detected in the destination 

Destinations Tab 

 

Destinations Tab: Icon Meanings 
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Resize Window: The 
INTELLIscribe window can be 
resized by dragging the lower 
right-hand corner of the status bar. 
 

F. Status Bar 

The status bar is displayed at the bottom of the INTELLIscribe window.  To display or 
hide the status bar, Select Status bar from the View menu. 
 
The status bar displays relevant messages when importing or exporting configuration 
files or when dealing with SLP printers. 
 

G. Log Tab 

The Log tab 
displays events 
logged during the 
course of operation.  
INTELLIscribe 
logs a number of 
messages during 
startup and a 
number of messages 
for each job that is 
captured or 
received.  Different 
processes in INTELLIscribe also log events, such as the process that monitors the 
Windows Print Manager for incoming print jobs and the ISendFile command line 
interface. 

Log Tab 

 
When INTELLIscribe stops printing, or has attempted to print something and failed, 
you should review the warning or error messages in the Log tab, as they may assist in 
resolving the issue.  When contacting technical support, you may be asked to submit 
your log file for review.  The log file is stored on disk in the Logfiles folder. 
 
Each message contains a timestamp, severity, type, name, message ID, and message.  
An icon next to each message shows the severity of the message: 
 
Icon Meaning 

 The message is just providing information. 

 A warning message that may require attention. 

 An error has occurred. 

 Log Tab: Icon Meanings 
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Appendix I: Brooks License Manager 

Software Licensing Instructions 
After INTELLIscribe is installed, you will have 21 days to trial the software.  At any 
time during the trial, you can purchase and license INTELLIscribe using the 
instructions below.  You do not need to re-download and install INTELLIscribe to 
license it.  You can use the order number and authentication code you receive after 
purchasing an INTELLIscribe license to unlock the software that is already installed.
 
Note  You must be logged on as an administrator to install and license Brooks’ 
Software on Windows 2000 or later platforms. 
 
Brooks’ products are unlocked through the Brooks License Manager application which 
is installed during product setup.  If the computer where the software is installed has 
Internet access, the Web Unlock Process should be used to unlock the software.  If the 
computer does not have Internet access, use the Manual Unlock Process. 

Web Unlock Process 
The Web Unlock Process uses the order number (invoice or sales receipt number) and 
an authentication code (listed as “Auth Code” on the invoice or sales receipt) to 
permanently unlock the software. 
 
1 Open the Brooks License Manager from the application’s Programs folder.  Or, 

choose License Manager from the software Help menu. 
2 Click the License button to start the Application Unlock Wizard.  Click Next. 
3 Enter the username and company for this license.  The username must be unique if 

unlocking more than one license. 
4 Select the default option Unlock using an order number and authentication code.  

Click Next. 
5 Now enter the order number (invoice or sales receipt number) and the 

authentication code (listed as “Auth Code” on the invoice or sales receipt) in the 
fields provided.  Click Next. 

6 Verify the proxy server settings are correct.  Note that the Brooks License 
Manager does not support proxy servers which require authentication.  Click 
Finish. 

7 If the unlock is successful, the completion page of the Application Unlock Wizard 
will display the following message: “Operation Complete.” 

8 If the unlock was unsuccessful, a message appears describing the reason why the 
attempt was unsuccessful.  You may contact Brooks for further information on 
error messages. 

 
Note  Please Print the License for Your Records 
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Manual Unlock Process 
If the computer does not have Internet access, the Manual Unlock Process should be 
used to unlock the software.  You may contact your reseller or Brooks to obtain the 
required information or you may use one of the methods below. 
 
1 Open the Brooks License Manager from the application’s Programs folder.  Or, 

choose License from the software Help menu. 
2 Click the License button to start the Application Unlock Wizard.  Click Next. 
3 Enter the username and company for this license.  The username must be unique if 

unlocking more than one license. 
4 Select the option Unlock using an unlock key.  Click Next. 
5 Edit the Support Expiration Date field to reflect the Software Upgrade 

Maintenance (SUM) expiration date.  This date is listed on your invoice or sales 
receipt.  Click Next. 

6 Enter the unlock key obtained using one of the methods below and click Finish. 
7 If the unlock is successful, the completion page of the Application Unlock Wizard 

will be displayed stating: “Operation Complete.” 
8 If the unlock was unsuccessful, a message appears describing the reason why the 

attempt was unsuccessful.  You may contact Brooks for further information on 
error messages. 

 
Note  Please Print the License for Your Records 

Options to Obtain Manual Unlock Information 
The following methods allow you to obtain the information required to unlock the 
software using the Manual Unlock Process.  Be aware these methods do not unlock the 
software, but provide a convenient means to obtain the information required during the 
Manual Unlock Process.  You may also contact us directly to obtain this information. 
 
Before proceeding, you will need to know the serial number.  This number is generated 
during program installation. 
 
1 Open the Brooks License Manager from the application’s Programs folder.  Or, 

choose License from the software Help menu. 
2 In the License Status tab, take note of the serial number. 

Option #1 - Online Key Generation Method 
1 Connect to the Internet and access http://www.brooksnet.com/cgi-

bin/order/unlock.html. 
2 Enter the required information: 

• Serial number  This number is generated during installation and can be found 
by opening the Brooks License Manager.  

• Product Name  From the drop down list select the name of the product 
purchased.  
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• Quantity  Keep the default of "1". This information is only required for module 
licensing.  

• User Name  Enter a UNIQUE identifier for the individual using the software or 
the machine containing the software (i.e. Jane Smith, West Coast Sales Office, 
Server A).  

• Company Name  Name of the company licensing the software.  
• Order Number  Invoice or Sales Receipt number provided when the order was 

processed.  
• Authentication (Auth) Code  Unique code (listed as “Auth Code” on the invoice 

or sales receipt) auto-generated and provided when the order was processed. 
3 Click the Submit button.  If successful, a page will be displayed with the unlock 

key and support expiration date. 
4 Follow the manual unlock process listed above. 

Software Reinstallations 
Brooks License Manager allows you to unlock the software using the same method 
provided you are installing it on the same computer.  The same serial number is 
generated each time the software is installed. 
 
Note  If your Software Upgrade Maintenance (SUM) has not expired at the time a new 
version is released, Brooks License Manager will also allow you to upgrade to that 
version using the same method. 
 

• Web Unlock Process – Use the original order number and authentication code 
found on the sales receipt or invoice. 

• Manual Unlock Process – Use the same unlock key and support expiration 
date.  Don’t forget to enter the correct support expiration date!  

 
If the software is installed on a different PC, it will be necessary to contact your reseller 
or Brooks to obtain new manual unlock information. 

After Hours Licensing 
For customers who have current Software Upgrade Maintenance (SUM), an After 
Hours Licensing solution is available in emergency or disaster recovery situations 
when the regular trial version is not sufficient to meet the customer’s needs. This 
solution is available for RPM Elite and Select only and provides a five day trial version 
allowing the same number of printers as if the license was unlocked. 
  
Before proceeding, you will need to know the Order Number (invoice or sales receipt 
number) and the Authentication Code (listed as “Auth Code” on the invoice or sales 
receipt).  
 
1 Connect to the Internet and access the following web page: 

http://www.brooksnet.com/faq/dl-5day.html. 
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2 Enter the appropriate information in the form displayed and click the Submit 
button.  All fields on this form are required. 

3 If your order number and authentication code are correct, and you have current 
SUM, a page will be displayed which will allow you to download the 5-day trial.  
Links to the manual are provided as a courtesy. 

4 If there is a problem, the form will be displayed again, and any error messages will 
be shown in red describing the reasons for the problem.  If so, correct the problem 
and try again. 

If you have already installed and configured RPM, follow the steps on the following 
FAQ to reinstall RPM using the five day trial version: 
http://www.brooksnet.com/faq/416-09.html. 
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Appendix II: Common Messages and Errors 

Printer Busy Notification 
This message will occur when printing if the host is unavailable or is busy.  If received, 
check the printer to see if it is turned on, and that there are no jobs currently being 
printed.  This notification can be enabled or disabled using the View > Options 
command. 
 
Note  INTELLIscribe attempts to determine why the printer or print server is busy and 
displays this information in the dialog. 

License Expired Notification 
When INTELLIscribe is installed, a 21-day 
trial period begins, even if you have already 
purchased the software.  INTELLIscribe 
must be unlocked after the 21-day trial; if it 
is not unlocked, or if the trial period has 
expired, INTELLIscribe displays this 
notification and the print job will fail. License Expired Error 
 
If you have purchased INTELLIscribe, you received instructions with your order to 
unlock it.  If INTELLIscribe has not already been purchased, contact sales by email at 
sales@brooksnet.com. 
 
Note  The Brooks License Manager is used for license management and unlock.  
Further information on licensing can be found in Appendix II: Brooks License 
Manager.
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user agent 
A software application that listens 
for information about network 
services from a Directory Agent or 
Service Agent.  

service agent 
An SLP software application used 
to broadcast the existence of 
network services. 

directory agent 
An SLP term that describes a 
centralized repository for service 
location information.  
 

Appendix III: Service Location Protocol (SLP) 

What is SLP? 
The Service Location Protocol (SLP) is an IETF standard protocol that allows 
applications the ability to discover the existence of services, such as printers, on a 
network.  SLP can also be used to find the location and configuration of services, 
reducing the amount of technical knowledge and training required for end users.  
Traditionally, each computer on a network requires manual configuration when 
services are added, removed, or modified. 
 
SLP is described in greater detail in the Request for Comments (RFC) listed below.  A 
minimum implementation requires a client, which is called a User Agent in SLP 
terminology, and a server which is called a Service Agent.  The Service Agent 
broadcasts the existence, location, and configuration of a particular service.  The User 
Agent requests information from the Service Agent, or if implemented, a Directory 
Agent.  A Directory Agent acts as a centralized repository for service location 
information. 
 
INTELLIscribe is a User Agent.  Information about printers that support the LPR/LPD 
protocol is located and a destination is added automatically with the information found.  
When a printer is removed from a Service or Directory Agent's configuration, 
INTELLIscribe automatically removes the destination. 

Request for Comments 
RFC 2165 - Service Location Protocol, Version 1 
RFC 2608 - Service Location Protocol, Version 2 
RFC 2609 - Service Templates and Service Schemes  
RFC 2610 - DHCP Options for Service Location Protocol 
RFC 2614 - An API for Service Location Protocol 
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Appendix IV: What's New? 

Version 4.0 
Features • Windows Vista operating system support 

• Cluster environment support 
• Shared Print Activator module is now included as a standard feature 
• During installation, you can select where shortcut icons are created 
• Added the ability to upgrade from previous versions (3.2.0.42 and 3.2.0.60) 

Resolved Issues • Resolves an issue where print jobs were not properly deleted 
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Version 3.2 
Features • A new column has also been added to the Print Jobs table to display which user printed the 

job. 
• Timeout support has been added to close a connection after a specified period of inactivity. 

This period is configurable in the Virtual Printer Port Wizard. 
• Print jobs can be dragged from one INTELLIscribe virtual printer port to another virtual 

printer port.  This allows you easily to send a print job that has already been scheduled for one 
port to another port for printing. 

• Print jobs can be dragged from INTELLIscribe to other applications that support drag and drop 
(e.g. Notepad, Outlook, and so on).  For example, dragging a print job to an editor allows you 
to view the print job file; dragging to an Outlook email attaches the print job to the email.  
Useful for troubleshooting. 

• You can specify how many days to store log files before they are removed. 
• You can specify the directory where INTELLIscribe’s Spool directory is located.  The Spool 

directory is where INTELLIscribe archives print jobs.  This will allow you to better utilize 
disk space. 

• You can specify the directory where INTELLIscribe’s log files are stored.  This will allow you 
to better utilize disk space. 

• You have the option to turn off the splash screen on startup. 

Resolved Issues • The INTELLIscribe user interface has been updated to be more responsive with large sets of 
data. 

• The service has been updated to resolve issues with destinations becoming stuck in a busy 
state, preventing jobs from printing. 

• Some log messages were not being displayed properly in INTELLIscribe. 
• Resolved various issues when dealing with network shares. 
• INTELLIscribe has better recovery from jobs cancelled at the printer: INTELLIscribe will not 

attempt to reprint jobs. 
• Using JetDirect, INTELLIscribe recovers and the printer does not stay in a Busy state when a 

job times out. 
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Version 3.1 
Features • Print jobs can be reprinted to a destination chosen by the user.  This allows failed print jobs to 

be reprinted to only the destinations that failed, or printed again to a destination of choice. 
• An option has been added that allows users and administrators the ability to specify a number 

of times a print job is retried before it fails. 
• Support for the Service Location Protocol (SLP) offers easier setup. SLP printers are 

automatically recognized and available for printing within seconds. Users no longer need to 
know the hostnames of network printers. 

• Testing has shown that INTELLIscribe transmits information much faster than before! 

Resolved Issues • If a destination was in an unknown state, jobs sent to it were getting "stuck" in a "submitted" 
state and did not print.  This has now been resolved. 

• Sometimes when printing, a destination would get "stuck" in a busy state before the print job 
would start printing.  The jobs are no longer getting stuck, but print right away. 

• Broadcast printing to LPR/LPD destinations using the standard or strict "Port Restriction" 
setting would sometimes fail when attempting to bind to a source port. 

• When a user without "Administrator" privileges attempted to print, occasionally an error was 
displayed. On other occasions, the print job would not be added to INTELLIscribe. 
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Version 3.0 
Core • Runs as a service on Windows NT/2000/XP platforms.  

• Export feature now saves configurations in XML.  
• Import feature now supports XML and configuration files from previous versions.  
• Configuration is stored globally rather than requiring a separate configuration for each user.  
• Job Deletion feature can now remove failed jobs.  
• Added two new policies to improve destination management: Round Robin and Destination 

Balancing.  
• Scheduling of print jobs is faster and more efficient.  
• TCP/IP transport now utilizes new features of WinSock 2 for greater efficiency.  
• Events are now stored in standard CSV files. Log can easily be viewed and sorted in 

applications supporting this format.  
• Windows can print simultaneously to multiple Virtual Printer Ports, improving speed and 

throughput.  
• Better integration with the Windows Print Manager. 

User Interface • New style menus and toolbars.  
• Log viewer provided for troubleshooting print jobs and destinations.  
• Destination Window added to allows users to update, view and query information about the 

destinations.  
• Enhanced the Virtual Printer Port Wizard.  
Context sensitive help added, allowing users to easily find a desired topic. 

Brooks License 
Manager 

• License Wizard enhancements ease administering license.  
• Supports advanced products and features.  
• Enhanced support for license reinstallation.  
• Web-unlock can connect through a proxy server/firewall. 

Resolved Issues • Files larger than 2 GB can now be printed, previously an error was reported.  
• Can print data from Lotus Notes even when attachments are included.  
• Eliminated all ISTMan.exe errors.  
• Jobs no longer get "stuck", they finish printing or fail.  
• Broadcast feature now works to more destinations, previously more than 40 or 50 destinations 

result in errors.  
• Multiple jobs can now be properly selected; previously the entire print job view was refreshed, 

canceling out the selection. 
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